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Abstract: Background: Valtrate (Val) was extracted from the Valeriana jatamansi Jones plant, had good antitumor

activity. However, its precise molecular mechanism in cancer cells was still unclear. This study investigated the effect of

Val on gastric cancer (GC) cells and its potential molecular mechanism. Methods: Cell viability was examined by CCK-

8 assay. Cell cycle, apoptosis, and Reactive oxygen species (ROS) level were analyzed by flow cytometry. The migration

effect of Val on AGS cells was analyzed by transwell and wound-healing assay. The expression levels of proteins were

analyzed by western blot. Results: The cell viability assay results demonstrated that Val significantly decreased GC cell

viability. Apoptosis assay results revealed that Val induced mitochondria-dependent apoptosis through the Bad/Bcl-2/

cyto-c/cle-casp-3/cle-PARP pathways. Further exploration found that Val induced apoptosis through increasing the

expression of phosphorylated p38 mitogen-activated protein kinase (p-p38), phosphorylated c-Jun N-terminal kinase

(p-JNK), and Inhibitor kappa B alpha (IκB-α) proteins and decreasing the expression of phosphorylated extracellular

signal-regulated kinase (p-ERK), phosphorylated signal transducer and activator of transcription 3 (p-STAT3), and

nuclear factor kappa-B (NF-κB) proteins; these expression levels of proteins were reversed by mitogen-activated protein

kinase (MAPK) inhibitor. Furthermore, Val induced G2/M phase arrest in AGS cells through downregulating the

expression of phosphorylated protein kinase B (p-AKT). Moreover, Val induced inhibition of AGS cell migration

through downregulating the expression of p-GSK-3β and β-catenin. In addition, Val promoted the ROS accumulation

of AGS cells. Further investigation found that Val-induced apoptosis, arrested the cell cycle, and inhibited cell

migration, and that its signaling pathways related to protein expressions were reversed by the ROS scavenger, N-acetyl-

L-cysteine. Conclusion: Val induced apoptosis, arrested the cell cycle, and inhibited migration by ROS-mediated

MAPK/STAT3/NF-κB, AKT/Cyclin B/CDK1/2, and GSK-3β/β-catenin signaling pathways in AGS cells.

Introduction

Gastric cancer (GC) is a global common malignancy and is
extremely harmful to human health [1]. The fatality rate of
GC is very high, with tens of millions of people dying from
the disease each year [2]. Surgery, radiotherapy, and

chemotherapy are the three pillars of tumor treatment, but
surgery and radiotherapy are only suitable for local
treatment, and only a very small percentage of patients
survive the first 5 years after therapy [3,4]. While
conventional chemotherapy addresses residual cancer cells
and decreases recurrence risk, it carries drawbacks like low
efficacy, numerous side effects, and a gloomy prognosis [5].
Therefore, the development of high-efficiency and low-
toxicity drugs is urgent for GC.

Natural medicine benefits from high-efficacy, low-
toxicity, and minimal negative effects and has been highly
valued by researchers [6,7]. Valtrate (Val) is the main active
component of the medicinal plant Valeriana jatamansi
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Jones, “The botanical name of the plant material was verified
using ‘The Plant List website–http://www.theplantlist.org’
(accessed on August 25, 2023)”. Which has good therapeutic
effects on anxiety and depression [8,9]. In addition, Val has
exerted good antitumor effects in pancreatic, breast, and
ovarian cancer cells by inducing tumor cell apoptosis [10–
12]. However, the antitumor activity of Val and its intrinsic
molecular mechanism has still received little investigation in
treating GC cells.

The dysfunction of cell apoptosis can lead to the
occurrence of tumors [13]. Natural drugs induce tumor cell
apoptosis and suppress tumor development. Therefore, they
have been widely studied by researchers [14–16]. Apoptosis
could be induced by a variety of pathways. As the control
center of cellular life activities, mitochondria are crucial in
regulating apoptosis [17]. In the Bcl-2 family, Bcl-2 and Bad
perform opposite functions in the cell apoptosis process
[18]. They are the key proteins of mitochondria-mediated
apoptosis and can regulate the permeability of the
mitochondrial inner membrane and lead to the release of
cytochrome c (cyto-c), which is a critical step in apoptosis
[19]. The cyto-c can bind to relevant apoptotic factors,
activate cleaved-caspase-3 (cle-casp-3) proteins, resulting in
a cascade reaction, then cleave substrate PARP (cle-PARP),
and lead to cell apoptosis [20].

Reactive oxygen species (ROS) are byproducts of cellular
metabolism, which are made up of many oxygen-containing
free radicals [21]. ROS are crucial in regulating cell apoptosis
and can activate various antitumor signaling pathways such
as mitogen-activated protein kinase (MAPK), signal
transducer and activator of transcription 3 (STAT3), and
nuclear factor kappa-B (NF-κB) [22,23]. Mitogen-activated
protein kinase (MAPK) signaling pathways can be activated
by various extracellular stimuli, such as oxidative stress,
cytokines, and hormones, and can regulate cell proliferation
and apoptosis [24]. The signal transducer and activator of
transcription 3 (STAT3) signaling pathways are involved in
the occurrence, proliferation, and immune evasion of tumor
cells [25]. Sustained activation of the nuclear factor kappa B
(NF-κB) leads to anti-apoptosis and uncontrolled cell growth
[26]. Furthermore, ROS can not only regulate cell apoptosis
but can also regulate cell cycle and migration by regulating
various signaling pathways [27,28].

The process by which a cell advances from the end of its
first division to the end of its second division is known as the
cell cycle [29]. The process is tightly regulated by many
signaling pathways and proteins [30]. If the signaling
pathway in this process is abnormally regulated,
uncontrolled cell division may occur, eventually leading to
tumorigenesis [31]. The protein kinase B (AKT) signaling
pathway, as a proto-oncogene, is crucial in tumor cell cycle
regulation and can regulate cell cyclin-related proteins
expression necessary to arrest the tumor cell cycle and
reduce proliferation [32].

Tumor cell migration can cause tumors to spread and
make tumor treatment more difficult [33]. The inhibition of
tumor cell migration has become an active research topic
regarding tumor treatment [34]. Glycogen synthase kinase
3β (GSK-3β) is a downstream protein of the AKT signaling
pathway that is essential for the development and growth of

tumors [35]. Inhibiting GSK-3β, a factor that promotes
cancer, would promote β-catenin to enter the nucleus,
activate the β-catenin signaling pathway, and finally inhibit
tumor cell migration [36].

In this study, the effects of Val on AGS cell apoptosis, cell
cycle arrest, and inhibition of migration, as well as their
molecular mechanisms were investigated.

Materials and Methods

Reagents
Val and 5-FU were obtained from Sigma-Aldrich (St. Louis,
MO, USA). After calculating the mass of the required
compound and the volume of 100% dimethyl sulfoxide
(DMSO, Solarbio, Beijing, China), the DMSO and the
compound were stirred and dissolved at 37°C aseptic
condition to prepare a 20 mM stock solution and stored
at −20°C.

Cell culture
Twelve types of GC cells (AGS, NCI-N87, YCC-6, SNU-484,
KATO-3, YCC-16, YCC-1, MKN-45, SNU-668, SNU-5,
MKN-28, and SNU-216) and human embryonic lung
fibroblasts (IMR-90) were obtained from the American Type
Culture Collection (Manassas, VA, USA). Human normal
gastric cells (GES-1), human liver immortalized cells
(THLE-2), and human embryonic kidney cells (293T) were
purchased from Saiqi Biotech Co., Ltd. (Shanghai, China).
Cells were cultured in an incubator with 5% CO2 and 37°C
using RPMI 1640 medium (Gibco, Waltham, USA) or
Dulbecco’s modified eagle medium (DMEM, Gibco) that
contains 10% fetal bovine serum (FBS, Gibco) and 1%
penicillin/streptomycin (P/S, Gibco). Logarithmic growth
phase cells were obtained and used in the experiment. The
cell density reached 80% to passage cells grown.

Cell viability assay
Ninety-six-well plates were seeded with twelve types of GC
cells and four types of normal cells (1 × 104 cells/well). Val
and 5-FU were treated at different concentrations for 24 h.
Cells were cultured in 10 μL of CCK-8 solution (Solarbio)
for 3 h without exposure to light. Cell viability was
measured using a microplate luminometer (BioTek
Instruments, Inc., VT, USA). The IC50 value was
determined using the GraphPad Prism 5.0 program. In
addition, Val and 5-FU, in accordance with their respective
IC50 values, treated cells for 0, 6, 12, 18, 24, and 30 h, and
the survival rates of each kind of cell were examined.

Cell apoptosis assay
Six-well plates were seeded with AGS cells (1 × 105 cells/well).
Val (30 μM, IC50 value) was treated for 3, 6, 12, and 24 h. The
apoptotic effect of Val on AGS cells was analyzed using
Annexin V-FITC Apoptosis Detection Kits (Solarbio). AGS
cells were stained with 4 μL of Annexin V-FITC and 2 μL of
propidium iodide (PI) in each well, then placed in the
dark for 15 min. After this morphology, the intensity of
fluorescence and apoptotic rate of the AGS cells were
analyzed using an inverted microscope (Mingmei
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Optoelectronics Co., Guangzhou, China) and flow cytometry
(Sysmex Co., Kobe, Japan).

A drop in mitochondrial membrane potential (MMP)
accompanied the apoptotic process. The MMP effect of Val
on AGS cells was analyzed using JC-1 Kit (Solarbio). 500 μL
1 × JC-1 working solution stained AGS cells for 30 min at
37°C. Then 500 μL pre-cooled 1 × washing buffer washed
away excess JC-1. The change in MMP was determined with
flow cytometry.

Western blot analysis
The lysis buffer was mixed with the collected cells for 30 min
to make a protein sample. Then, 8–12% SDS-PAGE gel
electrophoresis was performed to fractionate proteins, and
proteins were then transferred to nitrocellulose membranes.
Which was then incubated in 5% skim milk for 2 h.
Primary antibodies of α-tubulin, Bad, STAT3, p-STAT3, cle-
casp-3, cle-PARP, p-GSK-3β, AKT, p38, p-p38, E-cadherin,
Bcl-2, IκB-α, NF-κB, β-catenin, GSK-3β, p-AKT, ERK, p-
ERK, Cyclin B, CDK1/2, N-cadherin, JNK, p-JNK, p21, p27,
IL-6, and cyto-c (Santa Cruz Biotechnology, Inc., Dallas,
USA) were added and incubated overnight at 4°C. After
that, secondary antibodies of anti-mouse and anti-rabbit
(ZSGB-Bio, Inc., Beijing, China) were added and incubated
for 2 h. Finally, proteins were visualized using an enhanced
chemiluminescnce kit (Tanon, Shanghai, China) and UVP
ChemStudio 515 (Schisen Micron Medical Electronics Co.,
Ltd., Shanghai, China).

ROS level assay
Six cm plates were seeded with AGS cells (1 × 106 cells/plate).
After Val (30 μM) treatment, AGS cells were stained by
DCFH-DA probe according to the ROS detection kit
(Beyotime Institute Biotechnology, Shanghai, China) for
30 min at 37°C. Finally, accumulations of ROS in AGS cells
were analyzed with flow cytometry.

Cell cycle assay
Six cm plates were seeded with AGS cells (1 × 106 cells/plate).
Val (30 μM) was treated for 3, 6, 12, and 24 h. The cells were
treated with 70% alcohol at 4°C for 4 h. A quantity of 100 μL
RNase A (10 μg/mL) treated cells at 37°C for 30 min, after
which 400 μL PI (10 μg/mL) was added to stain AGS cells
for 20 min. Finally, the cell cycle was analyzed with flow
cytometry.

Cell migration assay
Six-well plates were seeded with AGS cells (1 × 105 cells/well).
When the cells reached 90% density, the tip of a 200 μL sterile
pipette was used to draw a line of equal width to form a
scratch. Then, the cells were treated with a medium
containing Val, and photographs of the scratch were taken
with an inverted microscope at 3, 6, 12, and 24 h. The
image analysis software “ImageJ” was used to measure and
analyze the scratch width at each time point. The “line tool”
was used to draw a line on each side of the scratch, and
click “Analyze” > “Measure” to take the measurement and
record the width of the scratch. In the transwell assay, AGS
cells (1 × 105) were added to the upper chamber of the

twenty-four-well transwell plates, and the medium did not
contain FBS. Medium containing 10% FBS was added to the
lower chamber, then placed in an incubator at 37°C and 5%
CO2 for incubation (3, 6, 12, and 24 h). After incubation at
each time point, and the cells in the lower chamber were
then stained with 0.1% crystal violet (Solarbio) for 10-
20 min and recorded by inverted microscope. Then, cell
counts were performed using ImageJ software. After
selecting area, “Image” > “Adjust” > “Threshold”, adjust the
threshold so that the cell area is black and the background
is white, click “Analyze” > “Analyze Particles”, then click
“OK” to analyze the count of cells.

Statistical analysis
All the data are expressed as the mean ± standard deviation
(SD) and were presented as a mean of three independent
experiments. The cell migration was analyzed by the ImageJ
software. The IC50 was calculated by SigmaPlot 15.0
software. SPSS 29.0 software was used to perform Tukey’s
post hoc test; multiple comparisons across the groups were
conducted using a one-way analysis of variance. A p value
of <0.05 was regarded as significant.

Results

Val exhibits the cytotoxic effect in GC cells
To determine whether Val can inhibit the viability of GC cells,
the viability of cells was determined by CCK-8 assay. It found
that Val significantly inhibited the viability of twelve types of
GC cells in a dose-dependent and time-dependent manner,
and the inhibitory effects of Val on the viability of GC cells
were much higher than that of 5-FU (Figs. 1A and 1B).
Table 1 displays the Val and 5-FU IC50 values for each GC
cell. To determine whether Val has a toxic side effect on
normal cells, four types of normal cells (IMR-90, 293T,
THLE-2, and GES-1) viability was determined by CCK-8
assay. It was found that Val did not clearly have a cytotoxic
effect on normal cells, and the cytotoxic effect of Val on
normal cells was significantly lower than that of 5-FU (Figs.
1C and 1D).

Val induces apoptosis in AGS cells
To verify whether the cytotoxic effect of Val on AGS cells was
associated with apoptosis, Annexin V-FITC and PI double
staining assay was performed. The results showed that Val
treatment exhibited significantly more fluorescence in the
AGS cells than the 5-FU group, and the fluorescence
intensity increased over time (Fig. 2A). The flow cytometry
results showed that the sum of the proportion of early and
late apoptosis induced by Val at 24 h significantly increased
to 40.45% compared with the untreated group (Fig. 2B).
Additionally, early apoptotic cells were accompanied by
changes in MMP. Val treatment reduced the MMP to 24%
at 24 h, which was the main characteristic feature of early
apoptosis (Fig. 2C). Further protein level analysis revealed
that Val treatment up-regulated Bad, cyto-c, cle-casp-3, and
cle-PARP expression and down-regulated Bcl-2 expression
(Fig. 2D).
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FIGURE 1. The cytotoxic effects of Val in GC cells. (A) Cells were treated with various concentrations of 5-FU or Val (20, 40, 60, 80, and
100 µM) for 24 h. Viability of twelve types of GC cells were detected using CCK-8 assay. (B) Cells were treated with 5-FU and Val IC50

concentrations for various times (6, 12, 18, 24, and 30 h). Viability of twelve types of GC cells were detected using CCK-8 assay. (C) Cells
were treated with various concentrations of 5-FU or Val (20, 40, 60, 80, and 100 µM) for 24 h. Viability of four types of normal cells were
detected using CCK-8 assay. (D) Cells were treated with 5-FU and Val IC50 concentrations for various times (6, 12, 18, 24, and 30 h).
Viability of four types of normal cells were detected using CCK-8 assay. *p < 0.05, **p < 0.01 and ***p < 0.001 vs. 5-FU.
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Val induces AGS cell apoptosis through the MAPK/STAT3/NF-
κB signaling pathways
To further investigate the molecular mechanisms responsible
for the Val-induced apoptosis of AGS cells, the expression
levels of MAPK/STAT3/NF-κB signaling pathway-related
proteins were detected by western blot. And found that after
Val-treated AGS cells, p-p38, p-JNK, and IκB-α expression
obviously increased, whereas p-ERK, p-STAT3, IL-6, and
NF-κB expression obviously decreased (Fig. 3A). In order to
verify the interaction and influence between MAPK and
STAT3 signaling pathways, the expression of p-STAT3
protein was detected by western blot after MAPK inhibitor
pretreatment, and the results showed that the inhibitory
effect of Val on the expression of p-STAT3 protein was
enhanced in the Val + ERK inhibitor (FR180204) treatment
group. The inhibitory effect of Val on the expression of p-
STAT3 protein was weakened in the Val + JNK inhibitor
(SP600125) treatment group and Val + p38 (SB203580)
inhibitor treatment group (Figs. 3B–3D).

Val induces AGS cell apoptosis via ROS-mediated MAPK/
STAT3/NF-κB signaling pathways
To investigate whether ROS are related to Val-induced
apoptosis, intracellular ROS level were detected by flow
cytometry and it found that treatment of AGS cells with Val
resulted in a gradually increase in intracellular ROS
accumulation over time (Fig. 4A). The accumulation of ROS
was decreased in GES-1 cells by Val (Fig. 4B). N-acetyl-L-
cysteine (NAC) is a commonly used antioxidant. The
regulatory role of ROS in Val-induced apoptosis of AGS
cells was further detected by NAC pretreatment. The results
showed that the summation of the ratio of early and late
apoptosis of the Val + NAC group was severely reduced
when compared to the Val alone treatment group (down
from 39.86% to 22.94%) (Fig. 4C). The inhibition of p-ERK,
p-STAT3, and NF-κB expression and the promotion of p-
p38, p-JNK, IκB-α, cle-casp-3, and cle-PARP expression
regulated by Val were reversed in the Val + NAC group
(Fig. 4D).

Val induces G2/M phase arrest in AGS cells
To investigate whether apoptotic cells induced by Val affected
the cell cycle, the cell cycle was detected by flow cytometry,
and the results showed that after Val treatment, the
proportion of cells in the G1 phase gradually decreased
from 53.34% to 34.83%, and the G2/M phase gradually
increased from 5.69% to 20.61% (Fig. 5A). To verify
whether ROS accumulation is involved in cell cycle
regulation, cell cycle distribution and cycle-related proteins
were further detected by NAC pretreatment in AGS cells.
The results showed that the percentage of G2/M phase cells
of the Val + NAC group was significantly decreased to
15.51%, which was significantly lower than that in the Val
alone treatment group (Fig. 5B). Subsequently, western blot
analysis results showed that Val treatment increased p21
and p27 expression, while p-AKT, CDK1/2, and Cyclin B
had the opposite effect (Fig. 5C). The inhibition of p-AKT,
Cyclin B, and CDK1/2 protein expression and the
promotion of p21 and p27 expression regulated by Val were
reversed in the Val + NAC group (Fig. 5D).

Val inhibits AGS cell migration
To investigate whether Val could inhibit AGS cell migration
and invasion, the effect of Val on AGS cell migration was
detected by wound-healing and transwell assay. And it
found that significantly fewer cells migrated when
comparing the Val group to the control group, and the
inhibitory effect became more apparent after 6 h (Fig. 6A).
In comparison to the control group, the wound-healing
trend in the Val group was severely hampered (Fig. 6B). To
verify whether ROS accumulation is involved in the
regulation of AGS cell migration, cell migration was further
detected by NAC pretreatment, and found that the wound-
healing rate of the AGS cells in the Val + NAC group was
significantly increased compared with that of the Val alone
group (Fig. 6C). The expression of migration-related
proteins was further examined and Val treatment increased
E-cadherin expression and decreased p-AKT, p-GSK-3β, β-
catenin, and N-cadherin expression (Fig. 6D). In the Val +
NAC group, Val-regulated p-AKT, p-GSK-3β, β-catenin,
N-cadherin, and E-cadherin expression were reversed
(Fig. 6E).

Discussion

As a common drug in chemotherapy, 5-FU has made some
progress in the process of tumor treatment, but the adverse
effects caused by its toxic side effects are difficult to
overcome [37]. Some studies have shown that natural drug
extracts have good antitumor effects and have the
advantages of low toxicity and high efficiency; therefore,
they have become a new choice for tumor treatment [38,39].
This study confirmed that Val has a cytotoxic effect on GC
cells, is significantly more effective than 5-FU, and has
lower toxicity on four types of normal cells. GC cells
showed different sensitivity to Val, which we speculated
might be due to the different cellular metabolites and drug
sensitivity of GC cells from different sources [40]. AGS cells
were the most sensitive to Val treatment, so AGS cells were
used as the experimental subjects in the subsequent

TABLE 1

IC50 values of Val and 5-FU in GC cells

Cell line 5-FU (μM) Val (μM)

AGS 104 ± 3.45 30 ± 2.32

MKN-28 103 ± 2.37 67 ± 3.51

MKN-45 106 ± 3.35 45 ± 2.65

NCI-N87 112 ± 2.86 54 ± 2.76

KATO-3 99 ± 3.41 49 ± 3.27

YCC-1 97 ± 2.89 52 ± 3.35

YCC-6 105 ± 3.64 43 ± 2.69

YCC-16 100 ± 3.12 48 ± 3.22

SNU-5 98 ± 2.76 63 ± 2.75

SNU-216 103 ± 3.37 57 ± 3.24

SNU-484 94 ± 2.52 51 ± 2.65

SNU-668 96 ± 3.45 50 ± 3.08
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experiments. Subsequently, we further investigated the
antitumor molecular mechanism of Val on AGS cells.

Inducing apoptosis of tumor cells was one of the methods
to inhibit tumors [41]. Studies have shown that Bad and Bcl-2
could regulate the release of cyto-c and then generate a caspase
cascade to regulate mitochondria-dependent apoptosis
[42,43]. In this study, we found that Val could induce
apoptosis through the Bcl-2 family pathway. In addition, we
found that when the cells were treated for more than 24 h, a
large number of AGS cells would be shed, which was not
conducive to the continuation of the experiment, so we
chose 24 h as the final treatment time point. One study
showed that Val could regulate pancreatic cancer cell
apoptosis by inhibiting STAT3 activity [10]. Indeed, the
STAT3 signaling pathway was also involved in the process
of Val-induced apoptosis of AGS cells. We further found
that the MAPK and NF-κB signaling pathways were also

involved in Val-induced apoptosis, and the MAPK signaling
pathway was located upstream of the STAT3 signaling
pathway for regulation by MAPK inhibitors treatment
experiments. Studies have shown that IL-6, as a cytokine,
can activate the IL-6 receptor on the cell surface, and then
activate receptor-related JAK enzymes (including JAK1 and
JAK2), and phosphorylated JAK enzymes can further
activate STAT3 protein, and then regulate the expression of
a series of genes [44,45]. In this study, we found that the
expression of IL-6 was significantly decreased after Val
treatment, and we speculated that Val could also regulate
the STAT3 signaling pathway by inhibiting the expression
of IL-6 and thus inhibiting the activation of JAK enzyme.

It is well known that tumor cells have higher levels of
ROS than normal cells and that excessive ROS in tumor
cells has a killing effect on tumor cells [46,47]. Studies have
revealed that some natural drugs could exert antitumor

FIGURE 2. The apoptotic effects of Val in AGS cells. AGS cells treated with 30 µM Val for various times (3, 6, 12, and 24 h). (A) AGS cells were
stained with Annexin V-FITC/PI, and cell morphology was observed using a fluorescence microscope (original magnification is 400×).
(B) AGS cells were stained with Annexin V-FITC/PI, and the apoptotic rate of cells was analyzed with flow cytometry. (C) AGS cells were
stained with JC-1, and the MMP of cells was analyzed with flow cytometry. (D) Expression levels of apoptosis-related proteins in AGS
cells were analyzed using western blot analysis. α-tubulin was used as an internal reference protein. *p < 0.05, **p < 0.01 and ***p < 0.001
vs. 0 h.
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effects by increasing ROS accumulation [48–50]. To verify
whether Val induced ROS accumulation in AGS cells, we
detected ROS levels and found that Val could increase ROS
accumulation in AGS cells. We further found that Val
promotes ROS accumulation and then regulates MAPK,
STAT3, NF-κB signaling pathways, and then induces cell
apoptosis by ROS inhibitor (NAC) treatment experiments.
Interestingly, the role of Val in promoting ROS

accumulation in tumor cells was opposite to that in normal
human gastric cells. The difference in results may be due to
the different metabolic pathways of cancer cells and normal
cells and the antioxidant defense mechanisms of cancer cells
may be altered. We speculated that Val may increase ROS
accumulation by increasing ROS production in cancer cells
or reducing their antioxidant defenses. In normal cells, Val
may reduce ROS accumulation by enhancing antioxidant

FIGURE 3. The regulatory effects of Val on MAPK, STAT3, and NF-κB signaling pathways in AGS cells. AGS cells were treated with 30 µM
Val for various times (3, 6, 12, and 24 h). (A) Expression levels of p-ERK, p-JNK, p-p38, p-STAT3, NF-κB, IL-6, and IκB-α proteins were
analyzed using western blot analysis. α-tubulin was used as an internal reference protein. *p < 0.05, **p < 0.01 and ***p < 0.001 vs. 0 h.
AGS cells were treated with 30 µM Val and/or 10 µM MAPK inhibitors (FR180204, SP600125, and SB203580) for 24 h. (B) Expression
levels of p-ERK, p-STAT3, cle-casp-3, and cle-PARP proteins were analyzed using western blot analysis. (C) Expression levels of p-JNK, p-
STAT3, cle-casp-3, and cle-PARP proteins were analyzed using western blot analysis. (D) Expression levels of p-p38, p-STAT3, cle-casp-3,
and cle-PARP proteins were analyzed using western blot analysis. α-tubulin was used as an internal reference protein. *p < 0.05, **p < 0.01
and ***p < 0.001 vs. control or Val + MAPK inhibitor groups.
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FIGURE 4. The promoting effects of Val on ROS accumulation in AGS cells. AGS cells were treated with 30 µM Val for various times (3, 6, 12,
and 24 h). The ROS levels of AGS cells treated by Val at different time points were distinguished by different colors, and then the ROS levels at
each time points were overlay for analysis. (A) Intracellular ROS level were analyzed with flow cytometry in AGS cells. (B) Intracellular ROS
level were analyzed with flow cytometry in GES-1 cells. AGS cells were treated with 30 µM Val and/or 10 mMNAC for 24 h. (C) The apoptotic
rate of AGS cells was analyzed with flow cytometry. (D) Expression levels of p-ERK, p-JNK, p-p38, p-STAT3, NF-κB, IκB-α, cle-casp-3, and
cle-PARP proteins were analyzed using western blot analysis. α-tubulin was used as an internal reference protein. *p < 0.05, **p < 0.01 and
***p < 0.001 vs. control or Val + NAC groups.
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defense mechanisms or reducing ROS production. However,
the current limitation is that the biochemistry and
molecular processes of cancer cells and normal cells are very
complex and may involve many different factors and
mechanisms, so it is difficult to determine through which
mechanisms Val exerts this effect, and the experimental
conditions may not fully mimic the environment in the
human body, and the results may not fully reflect what
happens in the human body.

Arresting the tumor cell cycle was the main means to
prevent the growth of tumor cells [51]. In different cycle
stages, corresponding CDK proteins would appear to bind
to corresponding cyclin proteins, which then regulate the
cycle [52]. To investigate whether Val-induced apoptosis
was related to the cell cycle, cell cycle checkpoints and
cyclin-related protein expressions were examined. We found
that Val induced AGS cell G2/M phase arrest and affected
the expression of related proteins in the G2/M phase. The

cell cycle arrest was also regulated by ROS. Research has
shown that if DNA damaged in cell cycle arrest is not
repaired, it could lead to apoptosis of tumor cells [53]. We
validated that Val could not only induce apoptosis directly
but also induce apoptosis by cell cycle arrest. Meanwhile, we
found that the degree of Val to cycle arrest was different in
different tumor cells, which might be due to the different
DNA repair capacities of different cells [54]. Currently,
DNA damage induced by drugs combined with other
therapies to kill malignant cells has become a focus of
intense study in the tumor treatment field [55]. To
contribute more effectively to the usage of combination
therapy with Val in the future, the different DNA damage
effects of Val in different tumor cells should be considered
in further studies.

The treatment of tumors is greatly hampered by the
migration of tumor cells [56]. One study has shown that Val
could inhibit migration by regulating MMP-2 and MMP-9

FIGURE 5. The arresting effects of Val on the cell cycle in AGS cells. (A) AGS cells were treated with 30 µM Val for various times (3, 6, 12, and
24 h). The percentage of cell cycle numbers was analyzed with flow cytometry. (B) AGS cells were treated with 30 µM Val and/or 10 mM NAC
for 24 h. The percentage of cell cycle numbers was analyzed with flow cytometry. (C) AGS cells were treated with 30 µM Val for various times
(3, 6, 12, and 24 h). Expression levels of the G2/M phase cell cycle-related proteins were analyzed using western blot analysis. α-tubulin was
used as internal reference protein. *p < 0.05, **p < 0.01 and ***p < 0.001 vs. 0 h. (D) AGS cells were treated with 30 µM Val and/or 10 mMNAC
for 24 h. Expression levels of the G2/M phase cell cycle-related proteins were analyzed using western blot analysis. α-tubulin was used as an
internal reference protein. *p < 0.05, **p < 0.01 and ***p < 0.001 vs. control or Val + NAC groups.
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FIGURE 6. The inhibitory effects of Val on cell migration in AGS cells. AGS cells were treated with 30 µM Val for various times (3, 6, 12, and
24 h), and cell migration was analyzed using an inverted microscope (original magnification is 100×). (A) Cell migration was analyzed using
transwell assay. (B) Cell migration was analyzed using wound-healing assay. (C) AGS cells were treated with 30 µM Val and/or 10 mM NAC
for 24 h. Cell migration was analyzed using wound-healing assay. (D) Cell migration-related proteins were detected using western blot analysis.
α-tubulin was used as an internal reference protein. *p < 0.05, **p < 0.01 and ***p < 0.001 vs. 0 h. (E) AGS cells were treated with 30 µM Val
and/or 10 mMNAC for 24 h. Expression levels of cell migration-related proteins were analyzed using western blot analysis. α-tubulin was used
as an internal reference protein. *p < 0.05, **p < 0.01 and ***p < 0.001 vs. 0 h, control, or Val + NAC groups.
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expression [11]. To verify whether the antitumor effects of Val
were associated with the inhibition of migration, the
migration ratio of AGS cells and their related pathway
protein expression were examined. We found that Val could
inhibit migration via the AKT/GSK-3β/β-catenin signaling
pathways in AGS cells. Further studies demonstrated that
the Val-induced inhibition of migration was regulated by
ROS. These results identify the underlying molecular
mechanism by which Val inhibited migration, which might
be a target for the inhibition of tumor migration in the
future. Although our study demonstrated that Val inhibits
cell migration by the AKT/GSK-3β/β-catenin signaling
pathways, there are still limitations to our study, such as we
did not examine the target genes of β-catenin that control
cell migration. Detection of this target gene can provide a
more detailed understanding of the molecular mechanism
by which Val inhibits cell migration. In future studies, we
will consider studying these target genes to further elucidate
the role of Val in cell migration.

Our study demonstrated that Val induced apoptosis,
arrested the cell cycle, and inhibited migration through
ROS-mediated MAPK signaling pathways in AGS cells
(Fig. 7). Val has shown good anti-GC efficacy with very low
toxicity and side effects and has the potential to be a future
therapeutic agent for GC. Although our study reveals the
anti-cancer mechanism of Val on GC cells, there are still
some limitations. Our study focused mainly on GC cells, but
the effects of Val on normal cells were not studied in depth.
This could affect our overall understanding of the
mechanism of action of Val, as there may be differences in
how the Val acts on cancer cells and normal cells. In future

studies, we will further investigate the effect of Val on
normal cells to more fully understand its mechanism of
action. In addition, we have not currently conducted
antitumor experiments on Val in vivo. However, we have
noted that other researchers have experimented with the
drug in vivo in other tumor types with some encouraging
results [53]. These experimental results suggest that the drug
has the potential to inhibit tumor growth. In the future, we
will validate our results in an in vivo model to evaluate the
efficacy and safety of Val against GC.
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